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GENERAL POLICIES AND REGULATIONS 

Student Integrity 

Conferral of a degree implies personal integrity and the ability to perform within the 

framework of scholarly methods. Three areas in which graduate students should be 

particularly cautious are the following: 

 

• Proper acknowledgment of cited works as outlined in discipline-specific style 

guides to prevent unintentional acts of plagiarism. 

 

• Use of copyrighted material. See the Copyright Law of the United States 

 

• Proper reporting of work subject to federal compliance regulations (e.g., use of 

human subjects). See the UWG Institutional Review Board (IRB) FAQ website 

 

It is the guiding principle of the University of West Georgia to maintain the highest standards 
of research and scholarship integrity regardless of the source of funding for that research or 
scholarship, or the type of research or scholarship being conducted. The University of West 

Georgia complies with guidance issued by the federal Office of Research Integrity by 
promoting ethical conduct in academic research and scholarship and all aspects of the 

research enterprise (Graduate Catalog – Responsible Conduct of Research).  

 

ADA Compliance 

Students are responsible for ensuring that their thesis or dissertation meets ADA 

accessibility standards before submission. Theses and dissertations should be reviewed 

using the built-in Accessibility Checker in Microsoft Word, and final PDF versions should 

be evaluated using Adobe Acrobat’s accessibility tools. These checks help confirm that 

elements such as headings, alt text for images, table structure, and reading order are 

properly formatted to support access for individuals using assistive technologies.  

1. In Word, access the “Review” tab and click on “Check Accessibility” 

2. Correct any errors and ensure that the following items have alt text  

a. Photos/Images 

b. Infographics 

c. Tables 

3. Save in Word 

http://www.loc.gov/copyright/
https://www.westga.edu/academics/research/orsp/irb-faq.php


 

4. Export the saved Word document to a PDF file (Do not save the document for 

print. Saving for print simply turns your document into a picture and loses all 

accessibility.) 

5. Check the PDF file of your thesis or dissertation for accessibility by accessing the 

Adobe Acrobat instructions 

 

ProQuest 

The University of West Georgia partners with ProQuest, a global online repository of 

research. All UWG students' theses and dissertations are submitted to ProQuest.    

Submission Procedure 

1. Students should save multiple copies of their thesis or dissertation as a Word 

document and PDF to several forms of electronic storage (e.g., SSD card, 

thumb drive, personal laptop, etc.). This ensures easier editing and retrieval of 

the most current work. Do not use OneDrive, as this platform can alter 

formatting and hinder PDF transferability from Word.  

2. The student is responsible for ensuring that all copies of their thesis or 

dissertation are accurate in both content and formatting before submission to 

ProQuest for review. Students should compare their required content pages 

to the sample content pages/templates provided in the appendix of this 

handbook to confirm proper formatting.  

3. Students must successfully defend their thesis or dissertation before 

submitting it to ProQuest.    

4. After a successful defense and approval by the committee, students must 

request approval to upload their thesis or dissertation to ProQuest through the 

ProQuest Submission Form. A PDF of the student's thesis or dissertation is 

required to be uploaded to the form.  

5. Once the student’s faculty advisor or dissertation chair has approved the 

student’s thesis or dissertation for upload to ProQuest, students will receive 

instructions on how to upload their document to ProQuest for the final format 

review. 

 
Students will be contacted by the “ETD Administrator” through their UWG email account 

and will be instructed to make any necessary formatting edits to their thesis or 

dissertation. Students will be notified once all formatting requirements are met and the 

submission has been approved.     

https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://app.smartsheet.com/b/form/43aefee872364fed91a96b3a2333ef3d


 

 

Deadlines 

Theses and dissertations must be submitted to ProQuest by the deadlines listed below: 

• Spring Graduation April 1 

• Summer Graduation July 1 

• Fall Graduation November 1 

*If the deadline falls on a weekend or holiday, then it is due on the following workday 

by 5:00 p.m. 

Adhering to these deadlines ensures students will have time to make any necessary 

edits to their thesis or dissertation prior to graduation deadlines.  

 

FORMAT AND STYLE GUIDELINES 

This handbook will assist in the preparation of the thesis or dissertation, but it is not 

meant to be an exhaustive manual. Students should consult the most recent edition of 

their discipline-specific style guide, except where the discipline-specific style guide 

instructions conflict with the guidelines laid out in this institutional guide. UWG style 

requirements take precedence to ensure consistency in thesis and dissertation 

formatting across disciplines. Read this handbook carefully before beginning the 

preparation of the thesis or dissertation. 

Typeface 

Times Roman or Times New Roman twelve-point font must be used throughout the 

document. Superscript characters should be no more than two points smaller than the 

font used for the body of the text. 

Margins 

Margins should be one inch on the left, top, right, and bottom of the page. The first page 

of the following should have a 2” top margin: Title page, Signature page, Abstract, 

Dedication, Acknowledgements, Preface, Vita, Table of Contents, List of Tables and 

Figures, chapters, reference pages, and appendices. Page two, and any subsequent 

pages, of any of the above-named sections return to the one-inch top margin. 

Line Spacing 

Line spacing should be double throughout the entire document, unless otherwise noted 

in the sections below. 



 

Pagination 

Lowercase Roman numerals (iii, iv, v, vi, etc.) should be centered at the bottom of the 

page for each of the required content pages. The Title page and Signature pages are 

assigned the page numbers i and ii, respectively, but these page numbers should not 

appear on the pages. Page numbering begins on the Abstract page with page iii.  

Arabic numerals (1, 2, 3, etc.) should be placed in the upper right corner of each page 

of the body text, the reference pages, and any appendices. The first page of the thesis 

or dissertation text is assigned the page number 1, but the page number should not 

appear on the page. Page numbering begins for the body text with the second page of 

the thesis or dissertation text with page number 2. This page numbering system should 

continue chronologically throughout the rest of the document with no subdivisions (1a, 

1-2, etc.). 

Widows and Orphans 

Most word processing systems have a setting that controls “widows” and “orphans” on a 

printed page. These are single lines of text that appear alone at the top or bottom of a 

page. Make sure that the widow/orphan setting for your word processing system is 

activated (many are set as the default) before converting your document to a pdf file. 

Required Content Pages 

Each thesis and dissertation should contain the following content pages, in the listed 

order, prior to the first page of the thesis or dissertation body text: 

1. Title Page 

2. Signature Page 

3. Abstract 

4. Copyright, Dedication, Acknowledgements, Preface (optional pages) 

5. Vita (optional page) 

6. Table of Contents 

7. List of Tables or Figures (if applicable) 

The thesis or dissertation body text should begin after the required content pages, 

followed by a list of references and any optional appendices. 

The Graduate School created templates for the required content pages, all of which can 
be found on the UWG Theses & Dissertations website or in the Appendices of this 
guidebook. 

Title Page 
 
Center the title of the thesis or dissertation at the two-inch top margin in ALL CAPS. If 

the title spans multiple lines, double-space the title and place the longer line of text first. 

https://www.westga.edu/academics/gradstudies/theses-dissertations.php


 

One double-space below the title, add “by” (lowercase), then another double-space 

below, add the student’s name in ALL CAPS (as registered at the University of West 

Georgia). 

Four double-spaced lines (adjusted if the title is longer) below, include: 
 “A [Thesis or Dissertation] Submitted to the Graduate Faculty of the University of West 

Georgia in Partial Fulfillment of the Requirements for the Degree of [Name of Degree].” 

Please modify this statement as needed. 

Another four double-spaced lines below, add “CARROLLTON, GEORGIA” in ALL CAPS, 

followed by the submission year, one double-space below.  

Signature Page 

Refer to the Appendix sample for the page layout. The Signature Page includes the 

names of the thesis or dissertation committee members and the student’s Dean, 

confirming that the thesis/dissertation is acceptable. 

Center the thesis or dissertation title at the two-inch top margin in ALL CAPS. After one 

double-spaced line, add “by” (lowercase), then another double-spaced line below, add 

the student’s name in ALL CAPS (matching the Title Page). 

Committee signatures: 

3 members: Start 5 double-spaced lines (adjusted for title length) below the name, 

aligned 3.5 inches from the left margin, type “Approved:” on the first line. Place the first 

signature line three single-spaced lines below, extending the line to the right margin. 

The committee chair’s name should be typed on the line; actual signatures are not 

required. “Thesis Advisor” or “Dissertation Chair” should be typed one single-spaced 

line below the signature line. Three single-spaced lines below, place the second 

signature line with the second committee member’s name typed on the line and 

“Committee Member” typed one single-spaced line below. Repeat this for the third 

committee member. 

4 members: Start three double-spaced lines below the thesis or dissertation title, with 

the same alignment and spacing as above. Follow the same format, adding signature 

lines for each member, with names typed on the signature lines and the label 

“Committee Member” typed one single-spaced line below.  

Dean’s approval: 
Left-justified at the one-inch margin, one double-spaced line below the last committee 

entry, add “Approved:” with a signature line three single-spaced lines below. Type the 

Dean’s name on the signature line; actual signatures are not required. A single-spaced 

line below the signature line, type “Dean,” and the name of the student’s college or 



 

school. One double-spaced line below, type the date the thesis or dissertation was 

successfully defended. 

Abstract 
 
An Abstract is required for every thesis/dissertation and typically includes the thesis or 

dissertation’s purpose, methods, key findings, and conclusions. 

Center “ABSTRACT” at the two-inch top margin in ALL CAPS. One double-spaced line 

below, add the student’s name in ALL CAPS, followed by a colon and the title of the 

thesis or dissertation (in upper and lower case). One single-spaced line below the title, 

include: “(Under the direction of [Advisor/Chair name]).” 

Begin the abstract text two double-spaced lines below. The text should be double-

spaced. If a second page is needed, return to a one-inch top margin. 

This page is assigned Roman numeral “iii” and is the first page number that is shown on 

the page. 

Copyright Page 

This page indicates copyright status of the thesis/dissertation. Please consult your 

committee if you are unsure whether your thesis/dissertation should be copyrighted. 

Place the copyright symbol (©) and year 20 double-spaced lines below the one-inch top 

margin. One single-spaced line below, add the student’s name (upper and lower case). 

One more single-spaced line below, include “ALL RIGHTS RESERVED” in ALL CAPS. 

Dedication (optional) 

Center “DEDICATION” at the two-inch top margin in ALL CAPS. Begin the double-

spaced text one double-spaced line below. If the dedication continues to additional 

pages, return to a one-inch top margin on those pages. 

Acknowledgements (optional) 

This page acknowledges those who assisted with the degree, including permissions for 

copyrighted material, grants, and funding. 

Center “ACKNOWLEDGEMENT” at the two-inch top margin in ALL CAPS. Begin the 

double-spaced text one double-spaced line below. Additional pages should return to a 

one-inch top margin. 



 

Preface (optional) 

The preface includes a brief, academic statement on the purpose and scope of the 

thesis or dissertation. 

Center “PREFACE” at the two-inch top margin in ALL CAPS. Begin the double-spaced 

text one double-spaced line below. Additional pages should return to a one-inch top 

margin. 

Vita (optional) 

The Vita is a one-page summary of the student’s academic background, professional 

experience, and major areas of study (no personal information should be included). 

Center “VITA” at the two-inch top margin in ALL CAPS. Text may be single- or double-

spaced. 

Table of Contents 

The Table of Contents format may vary in style and amount of information included and 

can use both single- and double-spaced lines. Include chapter/section titles, 

Bibliography/List of References, Appendices (if used), and the Vita. Appendix page 

numbers should reflect either the single page or the title page preceding multi-page 

sections. 

Students may be selective regarding the level of headings included in the Table of 

Contents, but inclusion must be consistent. If one heading is included, all headings of 

that level must be listed. Include all required content pages starting from the Abstract 

onward in the Table of Contents. 

Page one of the Table of Contents starts at the two-inch top margin. Additional pages, if 

needed, return to a one-inch top margin. 

List of Tables, Figures, and Illustrations 

If the thesis/dissertation includes five or more tables or figures, include a List of Tables, 

Figures, and/or Illustrations after the Table of Contents. Include any tables, figures, or 

illustrations from the appendices. Each title must be unique and match exactly as it 

appears on the table, figure, or illustration in the text. 

Page one of the List of Tables, Figures, and/or Illustrations starts at the two-inch top 

margin. Additional pages, if needed, return to a one-inch top margin. 



 

Body of Text 

Follow the current discipline-specific style manual for the thesis/dissertation text. Divide 

the document logically and consistently, typically by chapters, though sections or parts 

are allowed. 

Each major division must be numbered consecutively, titled concisely, and started on a 

new page. Begin each chapter/section number and title at the two-inch top margin. 

Subsequent pages return to a one-inch top margin.  

Tables, Figures, and Illustrations 

Tables, figures, and illustrations must fit within the established page margins. 

• Tables: Quantitative; organize so comparable entries are adjacent. Labels 

appear above the table.  

• Figures: Include photographs, maps, drawings, graphs, or charts. Text within 

figures may use any legible typeface, but the figure number and title must match 

the thesis/dissertation typeface.  

Large figures spanning multiple pages should show the figure number and full title on 

the first page; subsequent pages display the remaining parts of the table/figure. 

Each table, figure, or illustration must have a unique, descriptive title—no duplicates. 

Titles appear above tables and below figures. Title styles and conventions must be 

consistent throughout. 

Tables, figures, and illustrations are numbered independently using Arabic numerals in 

the order first mentioned in the text (e.g., Table 5, Figure 6). Do not use suffix letters or 

combine related tables into one table. 

All tables and figures must be referenced in the text by number, not by phrases like “in 

the following table/figure.” When multiple items appear on a page, place them in the 

order mentioned. Tables and figures are secondary to the text; text pages must remain 

filled and not left largely blank for the inclusion of tables/figures. 

Tables, figures, and illustrations should appear within the text, not the appendices. It is 

recommended to place them on a separate page immediately after the text where the 

table/figure is first referenced (e.g., Table 1 referenced on page 7 → Table 1 on page 8 

→ text resumes on page 9). 



 

If students choose to incorporate tables and figures within the text, the following rules 

apply: 

• Separate from text by ~½ inch of extra space  

• Tables and figures cannot be split and continue onto the next page  

Maintain a balance of at least ½ page of text and no more than ½ page of table/figure 

per page. Multiple, smaller tables/figures may be placed together on one page with ~½ 

inch spacing between them. Small diagrams or brief compilations (≤3 lines) need not be 

labeled as tables or figures. 

Large tables/figures may be turned to a landscape orientation to maintain the one-inch 

margins. Page numbers must follow the established pattern. The table/figure and 

caption should be readable when the page is turned 90° clockwise. 

Bibliography/References/Works Cited 

A thesis or dissertation must include a list of materials used, either as a List of 

References (cited in the text) or a Bibliography (also including consulted works). The list 

serves to: 

1. Acknowledge sources  

2. Allow readers to locate materials  

3. Provide context for personal interviews or correspondence  

The section title, using the discipline-specific term, should appear at the two-inch top 

margin; the first entry is one double-space below. Subsequent pages return to a one-

inch top margin. Format entries according to the current discipline-specific style manual. 

References must appear at the end of the thesis/dissertation, not at the end of chapters 

or sections. 

Appendix/Appendices 

The Appendix provides material relevant to the text but is unsuitable for inclusion within 

it. If included, it begins with a title/separation sheet labeled “Appendix” or “Appendices” 

at the two-inch top margin. This page receives a page number. Appendices must appear 

at the end of the document, not at the end of chapters or sections. 

Subdivided appendices must follow a logical order. Each separate appendix should be 

assigned a chronological number or letter (1, 2, 3 or A, B, C) and is titled at the two-inch 



 

top margin. The content should either start one double-space below the title or on the 

next page. Avoid page numbers with letters, hyphens, periods, or parentheses (e.g., 1a, 

1-2, (1)). 

  



 

THESIS AND DISSERTATION CHECKLIST  

Title Page and Signature Page  

❑ Is the title worded exactly as it is on the abstract?  

❑ Does your name on both pages match?  

❑ Does the page show a 2” (two-inch) margin at the top?  

❑ Does the format of your title page match the template?  

Abstract  

❑ Is the title worded exactly as it is on the title page?  

❑ Does your name match what is indicated on the title and signature pages?  

❑ Does the page show a 2” (two-inch) margin at the top?  

❑ Does the format of your abstract match the template?  

❑ Does the second page (if any) return to a 1” (one-inch) margin at the top?  

❑ Is the text of your abstract no longer than 250 words?  

❑ Have you placed this page immediately after the signature page?  

❑ Is this page(s) numbered in lower case Roman numerals (iii)?  

Copyright Page  

❑ Does your name match the title, signature, and abstract pages?  

❑ Does the format of your copyright page match the template?  

❑ Have you placed this page immediately after the abstract?  

❑ Is the copyright page numbered in lower-case Roman numerals at the bottom 
center of the page (e.g., iv)?  

Dedication, Acknowledgement(s) and/or Preface (optional)  

❑ Does the first page of each show a 2” (two-inch) margin at the top?  

❑ Do the following pages of each section return to the 1” (one-inch) margin?  

❑ Do each of these content pages begin on a new page?  

❑ Are the pages numbered in lower-case Roman numerals at the bottom center of 
the page (e.g., v, vi, vii)?  

Vita (optional)  

❑ Does the page show a 2” (two-inch) margin at the top?  

❑ Does the format of your vita page match the template?  

❑ Does the page list your discipline-related educational and professional positions? 

❑ Does the page list your major area of study and the focus of your content 

specialty area? 



 

Table of Contents 

❑ Does the first page show a 2” (two-inch) margin at the top?  

❑ Do the second and subsequent pages of the Table of Contents return to the 1” 

(one-inch) margin on all sides?  

❑ Does the format of your Table of Contents match the template?   

❑ Do the wording, capitalization, and punctuation of all entries match those used in 

the text of your thesis or dissertation?  

❑ Are the page numbers listed accurately?  

❑ Are the page numbers assigned to the Table of Contents pages in lower-case 

Roman numerals at the bottom center of the pages?  

List of Tables, Figures, and Illustrations 

❑ Does the first page show a 2” (two-inch) margin at the top?  

❑ Do the second and subsequent pages of the List of Tables, Figures, and 

Illustrations return to the 1” (one-inch) margin on all sides?  

❑ Does each list have a heading in all caps (LIST OF TABLES)?  

❑ Are all lists of tables, etc., properly numbered, given a title, and listed 

consecutively?  

❑ Do the wording, capitalization, and punctuation of all entries in your lists match 

those used in the text of your thesis or dissertation?  

❑ Have you placed these pages immediately after the Table of Contents?  

❑ Are these pages numbered with lower-case Roman numerals at the bottom 

center of the page? 

Chapters 

❑ Does the first page show a 2” (two-inch) margin at the top?  

❑ Do the second and Subsequent pages of the text, except the first page of 

succeeding chapters, return to the 1” (one-inch) margin on all sides? 

❑ Is the text double-spaced?  

❑ Are paragraphs indented consistently throughout?  

❑ Is the spacing between paragraphs consistent throughout the document?  

❑ Are the page numbers of the text in Arabic numerals without any additional 

punctuation?  

❑ Are page numbers placed in the upper right corner except on the first page of 

Chapter One? 

 



 

Bibliography/References/Works Cited 

❑ Does the first page show a 2” (two-inch) margin at the top?  

❑ Do the second and subsequent pages of the Bibliography/References return to 

the 1” (one-inch) margin on all sides?  

❑ Does the format match the template?  

❑ Are all entries listed in alphabetical order?  

❑ Do all entries follow the latest style manual for your discipline? 

Appendix/Appendices 

❑ Does the first page show a 2” (two-inch) margin at the top?  

❑ Do the second and subsequent pages of the Appendix/Appendices return to the 

1” (one-inch) margin on all sides?  

❑ Is the information relevant to the document but not suitable for inclusion within 

the text?  

❑ Have you assigned each appendix a number or letter and a title?  

❑ Have you placed all appendices after the bibliography or reference list? 

Final Checklist 

❑ Is the text double-spaced, with only the specified exceptions?  

❑ Is all text in Times Roman or New Times Roman, 12 pt.?  

❑ Do your pages match the templates?  

❑ Are your pages in the correct order?  

❑ Are your pages numbered correctly?  

❑ Do all your thesis/dissertation titles match on the title page, signature page, and 

abstract?  

❑ Do the chapter and division titles match on the Table of Contents and in the text?  

❑ Do all of the new chapters begin on new pages with a 2” (two-inch) margin at the 

top?  

❑ Is the general formatting consistent? 

❑ Are the entries on your Bibliography or Reference page listed alphabetically and 

comply with the latest edition of your discipline-specific style manual?  

❑ Have you placed all appendices after the bibliography or reference list? 

 

 



 

APPENDICES 

Templates 

The following templates can be used to help with the structure and formatting of your 

thesis or dissertation.  

• Title Page 

• Signature Page 

• Abstract 

• Copyright Page 

• Optional Pages 

o Dedication 

o Acknowledgements 

o Preface 

o Vita 

• Table of Contents 

• List of Tables 

• List of Figures 

• Chapter 1 

• Chapter 2 

• Chapter 3 

• Chapter 4 

• Chapter 5 

• Bibliography 

• Appendices 

• Appendix A 

• Appendix B 

 

 

 

 

 

 

 



 

 

INSERT YOUR TITLE HERE IN ALL UPPERCASE LETTERS: IF YOUR TITLE IS MORE 

THAN ONE LINE, THE LONGEST LINE SHOULD BE FIRST 

by 

ENTER YOUR NAME HERE IN ALL CAPS 

 

 

 

A [Thesis or Dissertation] Submitted to the 

Graduate Faculty of the University of West Georgia in Partial Fulfillment 

of the Requirements for the Degree of  

[Name of Degree] 

 

 

 

CARROLLTON, GEORGIA 

[Year] 



 

 

 TITLE OF THESIS OR DISSERTATION 

by 

STUDENT FULL NAME 

 

 

 

 

Approved: 

 

 

[Typed Name]  

Committee Chair 

 

[Typed Name]  

Committee Member 

 

[Typed Name]  

Committee Member 

 

Approved: 

 

 

[Name of Dean]  

Dean, [Name of School or College] 

 

 

[Date Approved] 

 



 

iii 
 

ABSTRACT 

 

STUDENT’S NAME: Enter Your Title Here Using Appropriate Upper and Lowercase Letters 

(Under the Direction of [Committee Chair’s Name]) 

 

 

 

 The double-spaced text of your abstract should begin here. Policy requires the submission 

of an abstract with each thesis or dissertation. Although the content of the abstract is determined 

by the student and committee, the following information is standard: 1) a short statement 

concerning the area of investigation; 2) a brief discussion of methods and procedures used in 

gathering the data; 3) a condensed summary of the findings, and/or 4) conclusions reached in the 

study. 

 ABSTRACT, using all uppercase letters, should appear centered on the first line of the 

page with a two-inch top margin. One double-space below, or two single spaces, enter the 

student’s name, using all uppercase letters, followed by a colon, then the title of the thesis or 

dissertation using upper and lowercase letters. A single space below the student’s name and the 

title, in parenthesis, add “(Under the direction of [insert name of thesis advisor or dissertation 

chair]).” The double-spaced text of the abstract should begin two double-spaces, four single-

spaces, below this information. The text can be completely left aligned, or each paragraph can be 

indented at the beginning, in accord with your discipline-specific style guide.



 

iv 
 

 The second page, if applicable, returns to the one-inch top margin. A section break has 

been created on this template to allow the different top margins. You may need to click the 

Show/Hide ( ¶ ) button on the Home tab in Microsoft Word to view the location of the break. If 

your abstract text is longer than one page, make sure that the section break is positioned at the 

bottom of the first page and you continue your abstract text after the section break, at the one-

inch top margin of the second page. 

If the abstract is only one page in length, please remove this page from the template 

before inserting the abstract into your final document.



 

v 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

©[Year] 

Student’s Name 

ALL RIGHTS RESERVED



 

vi 
 

DEDICATION 

 The dedication page is optional but, if a student wishes to dedicate the thesis or 

dissertation, the dedication statement is included on this page. DEDICATION should appear 

centered at the two-inch top margin using all upper-case letters. The text of the dedication 

statement should begin left aligned and a double-space below DEDICATION.  

Most dedication statements are brief enough to fit onto one page but if your statement is 

longer than one page, please navigate to the “Layout” tab in Microsoft Word and insert a “Next 

Page” section break (not a page break) at the end of the first page of text. Make sure that the 

second page of the dedication, which should begin after this section break, returns to a one-inch 

top margin. 

If you choose not to dedicate your thesis or dissertation, please remove this page from the 

document 

 

 

 

 

 

 

 

 

 



 

vii 
 

ACKNOWLEDGEMENT 

 The acknowledgement page is optional, so if you choose not to use this page, please 

remove it from the document. This page is used to thank those who have helped in the process of 

obtaining the graduate degree. Permission to quote copyrighted material is listed here, as well as 

acknowledgement for grants and special funding. 

 ACKNOWLEDGEMENT should appear centered at the two-inch top margin using all 

upper-case letters. The text should be double-spaced. Many acknowledgement pages will extend 

beyond the first page. If your acknowledgement text is longer than one page, please navigate to 

the “layout” tab in Microsoft Word and insert a “Next Page” section break (not a page break) at 

the end of the first page of text. Make sure that the second and subsequent pages, which should 

begin after this sections break, return to a one-inch top margin. 

 

 

 

 

 

 

 

 

 

 



 

viii 
 

PREFACE 

 A personal statement about the purpose and scope of the thesis or dissertation would be 

included in the preface. The tone of a preface, however, must be academic and appropriate to 

scholarly work. The preface is optional, so please remove this page from the document if you 

decide not to use it. 

 PREFACE should appear centered at the two-inch top margin, using all upper-case 

letters, and the preface text should begin a double-space below. As with previous pages, if your 

preface text is longer than one page, please navigate to the “Layout” tab in Microsoft Word and 

insert a “Next Page” section break (not a page break) at the end of the first page of text. Make 

sure that the second and subsequent pages, which should begin after this section break, return to 

a one-inch top margin. 

 

 

 

 

 

 

 

 

 

 



 

ix 
 

VITA 

The vita page is another optional page and can be removed from the document, if not used. It can 

also vary in style. The only formatting stipulation is that VITA should appear centered at the two-

inch top margin using all upper-case letters. The one-page vita presents the student’s educational 

and professional experience related to the academic discipline. It also presents the student’s 

major areas of study. The vita contains appropriate academic and professional information about 

the author/student. Personal information should not be included. Text may be both single and 

double-spaced. 
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CHAPTER I 

 This is where the text of your thesis or dissertation begins. Use the Normal text style. 

Heading 1 

 Body text 

Heading 2 

 Heading 2 is information apart of Heading 1. For example, Heading 1 is Major League 

Baseball and Heading 2 could be history of major league baseball. 

Heading 3 

 Heading 3 is a subset of heading 2, which is a subset of heading 1. So in this case, under 

history of major league baseball, a third heading could be MLB during WWII. 

 Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor 

incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation 

ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor in reprehenderit 

in voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat 

non proident, sunt in culpa qui officia deserunt mollit anim id est laborum. 

 Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod tempor 

incididunt ut labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud exercitation 

ullamco laboris nisi ut aliquip ex ea commodo consequat. Duis aute irure dolor in reprehend
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in voluptate velit esse cillum dolore eu fugiat nulla pariatur. Excepteur sint occaecat cupidatat 

non proident, sunt in culpa qui officia deserunt mollit anim id est laborum. 

 A “Next Page” section break (not a page break) was inserted at the bottom of the first 

page of Chapter 1 to allow the second and subsequent pages to revert to a one-inch top margin. It 

may be helpful to click the Show/Hide ( ¶ ) button on the Home tab in Microsoft Word to view 

the location of the break. Make sure that the section break is positioned at the bottom of the first 

page of Chapter 1 and that you continue your body text after the section break, at the one-inch 

top margin of the second page.
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CHAPTER II 

 Body text 

Heading 1 

 Body text 

Heading 2 

 Heading 2 is information apart of Heading 1. For example, Heading 1 is Major League 

Baseball and Heading 2 could be history of major league baseball. 

Heading 3 

 Heading 3 is a subset of heading 2, which is a subset of heading 1. So in this case, under 

history of major league baseball, a third heading could be MLB during WWII. 

 Continue with your text for Chapter II until the end of the first page of the chapter. Make 

sure that the section break rests at the bottom of the first page of the chapter, then continue your 

text for Chapter II on the second page. Make sure to format the second and subsequent pages of 

each chapter to begin at a one-inch top margin. Only the first page of each chapter should have a 

two-inch top margin.
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CHAPTER III 

 Body text 

Heading 1 

 Body text 

Heading 2 

 Heading 2 is information apart of Heading 1. For example, Heading 1 is Major League 

Baseball and Heading 2 could be history of major league baseball. 

Heading 3 

 Heading 3 is a subset of heading 2, which is a subset of heading 1. So in this case, under 

history of major league baseball, a third heading could be MLB during WWII. 

 Continue with your text for Chapter III until the end of the first page of the chapter. Make 

sure that the section break rests at the bottom of the first page of the chapter, then continue your 

text for Chapter III on the second page. Make sure to format the second and subsequent pages of 

each chapter to begin at a one-inch top margin. Only the first page of each chapter should have a 

two-inch top margin.
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CHAPTER IV 

 Body text 

Heading 1 

 Body text 

Heading 2 

 Heading 2 is information apart of Heading 1. For example, Heading 1 is Major League 

Baseball and Heading 2 could be history of major league baseball. 

Heading 3 

 Heading 3 is a subset of heading 2, which is a subset of heading 1. So in this case, under 

history of major league baseball, a third heading could be MLB during WWII. 

 Continue with your text for Chapter IV until the end of the first page of the chapter. Make 

sure that the section break rests at the bottom of the first page of the chapter, then continue your 

text for Chapter IV on the second page. Make sure to format the second and subsequent pages of 

each chapter to begin at a one-inch top margin. Only the first page of each chapter should have a 

two-inch top margin.
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CHAPTER V 

 Body text 

Heading 1 

 Body text 

Heading 2 

 Heading 2 is information apart of Heading 1. For example, Heading 1 is Major League 

Baseball and Heading 2 could be history of major league baseball. 

Heading 3 

 Heading 3 is a subset of heading 2, which is a subset of heading 1. So in this case, under 

history of major league baseball, a third heading could be MLB during WWII.  Continue with 

your text for Chapter V until the end of the first page of the chapter. Make sure that the section 

break rests at the bottom of the first page of the chapter, then continue your text for Chapter V on 

the second page. Make sure to format the second and subsequent pages of each chapter to begin 

at a one-inch top margin. Only the first page of each chapter should have a two-inch top margin. 
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APPENDIX A 

Place Appendix A here. 
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APPENDIX B 

Place Appendix B here. 

 

 

 

 

 

 


